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i. Getting Started 

 
To start using Advanced Flash Player, there are a few checks you may need to 

make to ensure your system compatibility. 

 
The prerequisites AFP requires on the system are the following: 

 

Microsoft .NET framework 1.1 or higher 
http://msdn.microsoft.com/netframework/downloads/framework1_1/ 

 

You can check to see if you already have the .NET Framework 1.1 installed by 

clicking Start on your Windows desktop, selecting Control Panel, and then 

double-clicking the Add or Remove Programs icon. When that window appears, 

scroll through the list of applications. If you see Microsoft .NET Framework 1.1 

listed, the latest version is already installed and you do not need to install it again.  

Macromedia Flash Plugin for Internet Explorer installed 

http://macromedia.com/go/getflashplayer 

 
The minimum system requirements are as follows: 

 

- 750MHZ processor 

- 32mb RAM available to AFP, at least 256mb total 

- 32mb onboard graphics / 16mb hardware graphics 

 

The main components which will increase program performance are the amount of 

available RAM, the .NET framework status and graphic processing speed. 

 

Once you have prepared your system with all the necessary prerequisites, visit our 

site, www.cr3ation.co.uk to download the latest build in ZIP format.  

 

 

 

 

 

Once you have unzipped the files into the folder, you can double-click on the program 

icon to start.  

If when running the program, an error window with code 0xc0000135 or with 

message "The dynamic link library mscoree.dll could not be found in the specified 

path..." pops up, you do not have the .NET framework installed. Run the framework 

installer program and try again to resolve this. Please note that you need to have 

sufficient rights (depending on your settings) to install the framework. 

It is important that you unzip the files into their own folder, and 

create shortcuts to the program from the new folder. The program 

will not run from the compressed archive. 
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ii. Troubleshooting Initialization 
 

If you see a message stating that dependencies have not been detected, you need to 

check that you have the correct prerequisites installed, and that the program has been 

extracted from the ZIP archive successfully. 

 

Example failure message 

 
 

When the program is loading, you will see a small information screen stating what is 

being loaded. The load time on an average system should not exceed 5 seconds. 

 

If you receive a .NET permissions error, you will need to speak to your 

network administrator as AFP does not have the correct privileges to run. 

You may also need to be logged in as an administrator to run AFP in rare 

cases. The initial setup process will need to be executed with an administrative 

account. 

You will need to confirm with your firewall that AFP is allowed to access the 

internet when the program loads. This is due to the built-in browser control. 

No data is sent, no data gathered. cr3ation has a strict anti-spyware policy. 



Copyright cr3ation technologies. Page 5 of 18 

iii. Player Controls & Sidebar 

 

The Sidebar 

 

 

When the main AFP screen appears, you will see this set of controls 

on the side of the window. These controls become active when data 

is loaded. 

 

At the top, the current build series and ID will be displayed, along 

with the current project status. Here, for example, we see that it is a 

Series 5 build, version 5072 in the Beta stage of development. 

 

- The “Play / Stop” button will freeze or continue the currently 

active movie. 

- Press “Fullscreen” to make the player occupy the whole 

screen area (on dual-screen systems, the primary screen will 

be targeted). 

- The “FF >>” button will fast forward the current movie by 

ten frames per 100 milliseconds, which is approximately 

thrice the working speed of most movies. The “<< RW” 

button will reverse the movie by ten frames per 100 

milliseconds. The reverse and fast forward features can be 

changed in their behaviour from the Options > Select Method 

menu, as seen below:  

 

 

 

 

 

Activating all frames will cycle through every frame while 

the movie is being fast forwarded or rewound. Activating 

every frame may cause some problems with the movie, and so 

there is also the choice to activate every 10
th
 frame instead. 

Activating every 10
th
 frame can produce choppier results 

during the process. 

- The “step” button will progress the movie one frame per 

approximately every 100 milliseconds. This can be useful for 

catching detail in fast-paced movies. 

- The “Back 1” and “Fwd 1” buttons can be used when the 

movie is stopped to progress or step back one frame. 
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 iii. Program Window, contd.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

- The “Freeze” button will stop the movie, and any 

controls which are processing its movement, such 

as Rewind, Fast Forward and “Step” 

- The “Open” button will bring up a small submenu, 

as shown below: 

 

 

 

 

o Clicking “Open URL” will bring up a 

second dialogue box, as follows: 

 

 

 

 

 

In this, you can type a URL to connect to. 

o Clicking “Open File” will bring up the 

standard operating system dialogue, which 

filters compatible file types. Locate the file 

you would like to open, and double-click 

on it to open. 

 

Some still image file types are not 

supported by the flash codec, such 

as certain JPG and GIF images. 

 

- Clicking “Quit Player” will save your settings and 

exit the program. 

- The “Movie Info” button will display the following 

information in a layer above the movie 

 

 

 

 

 

 

 

 

 

This feature will not work correctly 

on interactive movies. 
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iii. Program Window, contd.  

 

 

 

 

- Clicking the “Minimize” button will send the player 

into the system tray. 

- “Reload” will clear the player’s buffer and cache and 

capture the movie from source again. If the movie is 

streaming from the internet, the connection will be 

restarted. 

- “Show All” will force the player to display all relevant 

information intended in the movie. This option can 

leave borders. This is the default play mode. 

- “Stretch” will force the movie into the player window. 

This option can severely distort the aspect ratio of the 

movie. 

- “No Border” will only display the parts of the movie 

the author intended you to see, but this option can also 

cut off some information. This mode is experimental. 

- “Quality” will increase the current movie’s vector 

quality. For movies with a high frames-per-second 

count, this is not suggested for full screen mode. 

- “More Frames” will reduce the current movie’s vector 

decoding quality. This will increase the frame-per-

second count that you can see, and reduces system 

strain notably on lower-end systems. 

- The “Find compatible files” and “Use Browser” 

features will be explained later in this document. 

- The slider bar at the bottom of the sidebar shows the 

current position that the movie is in. You can move the 

slider to navigate around the file. 
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iv. System Menu  

 

 

At the top of the AFP window, you will see a horizontal grey bar; this is the system 

menu. The structure is as follows: 

 

File / View 

- Play / Stop 

- Open Movie  

o Open File 

o Open URL 

- Quit 

 

Features 

- Movie Info 

- Reload Flash Movie 

 

Modes 

- Full Screen 

- Optimize for quality 

- Optimize for more frames 

- Stretch to window 

- Show no border 

- Show all 

 

Options 

- Flash Plugin Options 

o Allow Plugin Menu 

o Use system fonts, not embedded 

- Pointer Options 

o Toggle Cursor 

� Cursor On 

� Cursor Off 

o Experimental Features 

� Deactivate cursor on fullscreen 

- Select Fast Forward / Rewind method 

o Activate all frames 

o Activate every 10
th
 frame 

- General Options 

o Resume movie on restart 

o Always on top mode 

 

Help 

- Internet Services 

o Upgrade flash plugin 

- Upgrade this beta 

- About AFP.NET 
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iv-1 System Menu – File / View 

 

The File / View menu controls the most basic aspects of the program. The structure is 

as follows. 

 

File / View 
 

Play / Stop 

The “Play / Stop” button will freeze or continue the currently active movie. 

 

Open Movie  

 

Open File 

Clicking “Open File” will bring up the standard operating system dialog, 

which filters compatible file types. Locate the file you would like to open, and 

double-click on it to open. 

 

Open URL 

Clicking “Open URL” will bring up a second dialog box. 

In this, you can type a URL to connect to. 

 

 

Quit 

This will save your settings and exit the program. 

 

iv-2 System Menu – Features 

 

The Features menu controls two useful options which are not present in the standard 

Macromedia projector. 

 

Features 
 

Movie Info 

The “Movie Info” button will display the following information in a layer above 

the movie: Frames per second, estimated length and estimated time left playing. 

 

Reload Flash Movie 

This will clear the player’s buffer and cache and capture the movie from source 

again. If the movie is streaming from the internet, the connection will be restarted. 
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iv-3 System Menu – Modes 

 

The Modes menu controls the flash plugin, and how it displays the information. 

 

Modes 
 

Full Screen 

Press “Fullscreen” to make the player occupy the whole screen area (on dual-

screen systems, the primary screen will be targeted.) 

 

Optimize for quality 

This will increase the current movie’s vector quality. For movies with a high 

frames-per-second count, this is not suggested for full screen mode. 

 

Optimize for more frames 

This will reduce the current movie’s vector decoding quality. This will increase 

the frame-per-second count that you can see, and reduces system strain notably on 

lower-end systems. 

 

Stretch to window 

This will force the movie into the player window. This option can severely distort 

the aspect ratio of the movie. 

 

Show no border 

This will only display the parts of the movie the author intended you to see, but 

this option can also cut off some information. This mode is experimental. 

 

Show all 

This will force the player to display all relevant information intended in the 

movie. This option can leave borders. This is the default play mode. 
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iv-4 System Menu – Options 

 

The Options menu controls every aspect of how AFP behaves. Some of the options in 

these menus can adversely affect the player and how the movies look if not used with 

caution. Every change you make in this menu can be reversed. 

 

Options 
 

Flash Plugin Options > 

 

Allow Plugin Menu 

This will hide or show the extended options available from right-clicking 

on the movie space. 

Use system fonts, not embedded 

For standard text in a flash movie, this option will force the plugin to use 

any available fonts installed on the system instead of the built-in fonts of 

the movie. This can reduce the visual appeal of a lot of movies; use only if 

necessary. 

 

Pointer Options > 

 

Toggle Cursor > 

 

Cursor On 

Clicking this shows the cursor when hovered over the player 

window. 

Cursor Off 

Clicking this hides the cursor when hovered over the player 

window. 

 

 

Experimental Features > 

 

Deactivate cursor on fullscreen 

This feature will attempt to hide the cursor when the player is in 

fullscreen mode. 

 

Select Fast Forward / Rewind method > 

 

Activate all frames 

Activating all frames will cycle through every frame while the movie is 

being fast forwarded or rewound. Activating every frame may cause some 

problems with the movie. 

 

Activate every 10
th
 frame 

Activating every 10
th
 frame can produce choppier results during the 

process but reduces ActionScript problems. 
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iv-4 System Menu – Options, contd. 
 

 

General Options >  

 

Resume movie on restart 

With this option, when you exit the player, the current movie’s location 

and current frame will be saved. When the player is started again, playback 

will resume from the same point. 

 

Always on top mode 

This option keeps the main window above all other windows. 

 
iv-5 System Menu – Help 

 

 

Help 

 
Internet Services > 

 

Upgrade flash plugin 

This will open the default internet browser (determined by the system) and 

navigate to the Macromedia download page. 

 

Upgrade this beta 

This will open the “Upgrade this beta” sub-program, which is explained later in 

this document. 

 

About AFP.NET 

This will open the “About” window, which is explained later in this document. 
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v. Internet Browser & Extractor 

 

AFP comes with a built-in internet browsing tool, which can extract Flash movie 

URLs to present in the main window. 

You can access the browser by either clicking the “Use Browser” button in the 

sidebar, or by clicking the tab below the system menu: 

 

  

 

 

 

 

 

 

 

The extraction tool can only extract Flash movie URLs when the Flash movie has 

been implemented into the page using, or code similar to, the following: 

 
<object classid="clsid:D27CDB6E-AE6D-11CF-96B8-444553540000" 

id="obj1" 

codebase="http://download.macromedia.com/pub/shockwave/cabs/fla

sh/swflash.cab#version=6,0,40,0" border="0" width="XX" 

height="XX"> 

 <param name="movie" value="URL"> 

 <param name="quality" value="High"> 

 <embed src="URL" 

pluginspage="http://www.macromedia.com/go/getflashplayer" 

type="application/x-shockwave-flash" name="XX" width="XX" 

height="XX"></object> 
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v. Internet Browser & Extractor, contd. 

The browser window 
The browser is built using an ActiveX Control. 

 

At the top of the browser window, there are 6 buttons: 

The “Back” and “Forward” buttons cycle through your visited page history; 

the “Search” button will navigate the browser to Google; “Reload” will reload the 

current page;  pressing “Stop” will halt navigation and image loading;  “Exit” will 

return to the player. 

 

 

 

 

 

 

 

 

 

 

At the bottom of the screen, you will see a list of successfully extracted URLs. 

Double-click on any of these to take the player back to the main window and stream it 

in AFP. 

You can switch between the player and browser screens, and the program will not 

lose your current page which you are navigated at. 

If HTML ERROR appears on your screen, the website you are browsing does 

not conform to W3C HTML 4.01 specifications.  
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vi. Media Library / Search Tool 

 

The Media Library & Search Tool can be accessed through the sidebar button. 

You can use it to search your local drives for either Flash media or all compatible 

media (Images and Flash). 

 

Window Appearance 

 
 
The main window contains 3 buttons, and a list box containing all located files. The 

first time you run the tool, you will be prompted to perform a search. If you select 

“Yes”, or press the “Rescan Library” button, the following prompt will appear: 

 

“Reload” will refresh the database, and “Close Library” will hide the window. 

 

 

 
 

Including images in your search can create very large database sizes, and is not 

advisable if you have a large photo collection. Press Yes to include, or No to scan for 

only Flash movies (recommended). Pressing Cancel will stop the search process. 
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vi. Media Library / Search Tool, contd. 

 

You will then be prompted for which device you would like to search. If a device is 

not ready, for example if a disc cannot be read, the search will be cancelled. 

 

Highlight a device, and press OK to continue. 

 

 
 

Virtual drives such as the Gmail drive or Nomad Explorer displayed here may not be 

searched unless mapped to a drive letter. 

 

The search status will be displayed in the lower part of the window. For larger drives, 

the search process can take up to 5 minutes. 

 

 
 

Once the scan has completed, you can double-click any of the files in the list to play 

them in AFP. 
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vii. Upgrade Tool 

 

This tool can be accessed via the system menu through Help > Upgrade this beta. 

 

Window Appearance 

 
 

The “Download new version” command button will open the system default browser 

and navigate to www.cr3ation.co.uk. 

 

“Prepare program for upgrade” will erase all AFP registry settings and then terminate 

all of the processes AFP is using. You should not need to use this function on AFP 

Stable releases, but during the Beta stage this feature will be present. 
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viii. Further Information 

 

For specific queries, technical support, or to donate to cr3ation, please send an email 

to admin@cr3ation.co.uk . 

 

AFP is freeware, and is not to be disassembled or resold without prior consent of 

cr3ation technologies. 

 

Please visit www.cr3ation.co.uk for the latest updates. 

 

IMPORTANT: 

AFP is currently beta software. This software stage should be considered unstable. 

cr3ation cannot be held responsible for any data loss or expense on behalf of AFP. 

You use the software at your own risk. 

 

ix. Copyright Acknowledgement 

 

Flash is a copyright of Macromedia ( www.macromedia.com ) 
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